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Description of menus and buttons

In the event that menu and button names on a Windows system are different from those on a Macintosh, this manual
uses the Windows menu and button names followed by the Macintosh menu and button names in parentheses.
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Getting Started

Overview of 01V96 Editor

01V96 Editor enables you to remotely control the Yamaha 01V96 mixing console and to save the
parameter settings on your computer. To use 01V96 Editor, you must first perform the following
operations:

1 Start and configure Studio Manager.

2 Start and configure 01V96 Editor.

Getting Started

3 Synchronize 01V96 Editor with your 01V96 console (see page 4).

For more information on using Studio Manager, refer to the Studio Manager Owner’s Manual.

Configuring 01V96 Editor

You must configure the following settings for each open Editor.

Note:

« Specify MIDI ports in the Setup window of Studio Manager before making the following settings.
+ To open each Editor, double-click the icon of the console or device you want to edit.
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d System Setup

To open the System Setup window, choose [System Setup] from the [File] menu.

Be sure to specify the Input port and Output port.

# Swstem Setup

Thput port |YP.MF'.HP. LisB IN 0-1 v|

Qutput port |YP.MF'.HP. USE OUT 0-1 V|

Conzole Device 1D

@1 Oz O3 O 4 o5 Qs o7 s

Channe| Select Confirmation
PG = Congole Store Confirmation
Congole -> PG [] Recall Confirmation

[] Patch Gonfirmation

Laver Select

PG -> Conzole indow Contral From Conszole
Caonzole = PG Enable

Level Meter

Enable

o =

Input port/Output port: From the ports you specified in Studio Manager, select the ports that
the editor will use to communicate with the 01V96 console.

Console Device ID: 01V96 Editor can control any one of up to eight 01V96 consoles, each with
its own exclusive ID. Select the ID of the console you want to control.
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Channel Select: These options determine whether or not channel selection is linked. When the
PC->Console option is on, selecting a channel in 01V96 Editor selects the same channel on the

console. When the Console->PC option is on, selecting a channel on the console selects the same
channel in 01V96 Editor.

Confirmation: These options determine whether or not a confirmation dialog box appears
when storing, recalling, or patching.
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Layer Select: These options determine whether or not Layer selection is linked. When the
PC->Console option is on, selecting a Layer in 01V96 Editor selects the same Layer on the console.

When the Console->PC option is on, selecting a Layer on the console selects the same Layer in
01V96 Editor.

Window Control from Console: This option determines whether or not using the USER
DEFINED KEYS on the console enables you to remotely open and close the 01V96 Editor win-
dows.

Level Meter: This option determines whether or not the level meters in 01V96 Editor are
enabled.

d Console Setup

%)
e
To open the Console Setup window, choose [Console Setup] from the [File] menu. =
L
£
)
+ Gonsole Setup (/)]
o
£
Surround Mode: g
(5) Sterea ok O 51 O 61 -g
Q
Pair Made 1-32) X
(&) Horizontal ) Vertical

Channel Copy Parameter

ALL: [ Fader [JON [JPAN [JSURR [ ALK [ AUXON [] EQ

’ [o] 4 ] | Cancel |

Surround Mode: Select a Surround mode from STEREOQ, 3-1, 5.1, and 6.1.
Pair Mode: These options determine whether the fader pair is Horizontal or Vertical.
Channel Copy Parameter: Select desired parameters to copy from channel to channel.
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Synchronizing 01V96 Editor

When 01V96 Editor starts up, the parameter settings on the console and the parameter settings in
01V96 Editor may be different. Therefore, you must first match the parameter settings on the con-
sole with those in 01V96 Editor. This operation is called “synchronization.” Follow the steps below
to synchronize 01V96 Editor.

1 Select [Synchronize], then [Total
Recall...].

The following window opens.

Getting Started

% 01Y96 — Synchronization

Direction
(&) Console > PG () PC —» Console

2 Select whether you want to transfer
your settings to 01V96 Editor, or vice [
versa.

QK ] ’ Cancel ]

At this time, the All Libs option determines whether or not Scene and Library data is synchronized.
PC -> Console: Transfers the current parameter settings in 01V96 Editor to your console.
Console -> PC: Transfers the current parameter settings of your console to the 01V96 Editor.

3 Click [OK].

A Do not operate the console while synchronization is in progress.

Note: If you use the “Total Recall” function in Studio Manager, all selected Editors in Studio Manager
are synchronized with the corresponding devices.

[2]
e
3
[2]
-
£
]
K=
()
©
=
©
o
E
Q
X

Offline Edit Function

If you do not want to synchronize your console with 01V96 Editor, select [Offline Edit] from the
[Synchronization] menu. To apply your off-line edits to your console, select [Re-Synchronize]
from the [Synchronization] with the PC->Console option to synchronize the console with 01V96
Editor.

The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the
Master window.

Note: Some effect parameters in the console change their displayed values depending on the sampling
frequency. If you switch 01V96 Editor from OFFLINE to ONLINE, displayed parameter values may
change because 01V96 Editor loads the sampling frequency from the console and updates the display.

Working with Sessions

All of your console’s mix settings in 01V96 Editor, including Scene and library data, are called Ses-
sions. The following table describes how to handle Sessions.

Creating a new Session Choose [New Session] from the [File] menu.
Opening a previously saved Session Choose [Open Session] from the [File] menu.
Saving the current Session Choose [Save Session] from the [File] menu.
Saving the current Session with a new name Choose [Save Session] As from the [File] menu.

Note: In order to save the settings of an optional Y56K card, in a Session, you must first resynchronize
01V96 Editor by selecting the Console->PC option.
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If you save a Session in an Editor, only that Editor’s settings are saved in a file. The Editor’s settings
are saved in either the Studio Manager V2 format (file extension “YSE”) or a format that is com-
patible with earlier versions of Studio Manager (file extension “01X”). Note that earlier versions of
Studio Manager cannot open a Session saved in the “YSE” format.

If you save a Session in the Studio Manager window, all selected Editor settings are saved in a file
with a file extension of “YSM.”

Undo/Redo Function

In 01V96 Editor, you can cancel the latest operation (Undo) and also cancel the cancellation of the
latest operation (Redo). If you perform an Undo operation twice in a row, you can cancel the two
most-recent operations. If you perform an Undo operation three times in a row, you can cancel the
three most-recent operations. In this way, you can cancel multiple recent operations. The following
table describes how to use the Undo/Redo function.

Undo Choose [Undo] from the [Edit] menu.

Redo Choose [Redo] from the [Edit] menu.

Please note, however, that after you perform one of the following operations, you cannot success-
fully undo or redo any previous operation:

+  Operations on the console

+  Closing Studio Manager

+ Changing Surround mode (Stereo/3-1/5.1/6.1)

+ Changing Pair mode (Horizontal/vertical)

+  Synchronizing the console with 01V96 Editor

+ Creating a new Session

+ Saving a Session

+ Copying and pasting a channel

+  Creating or cancelling a channel pair

+  Storing or recalling a scene or library

+ Turning on or off the GATE: [LINK] button in the Selected Channel window
+  Turning on or off the COMPRESSOR: [LINK] button in the Selected Channel window
+ Turning on or off the [LINK] button in the Surround Editor window

+ Changing Aux Send mode (Fixed/variable) on the console

+ Changing the sampling frequency (operated on the device)

+ Changing the User Assignable Layer settings (operated on the device)

Note: You cannot Undo or Redo the following operations:
« Edits in the Setup window

* Synchronization

* Opening and closing the windows

* Resizing the windows

Note: In the Library window, you can Undo or Redo only the most recent operation. You cannot cancel

the preceding operations.
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Other Functions

J Copy & Paste Function

You can copy and paste the channel parameters.

Getting Started

In the Console Setup window (page 3), you can also specify the parameters to be copied.

The following table describes how to use the Copy & Paste function.

Copying a channel Right-click (<control>+click) a copy source channel, then choose [Copy].

Right-click (<control>+click) the copy destination channel, then choose

Pasting a channel [Paste].

1 Resetting to the default value (Ctrl (38) + click)

Move the cursor to a control or a parameter value, then hold down the <Ctrl> key (88) and click
the mouse button to reset the value to the default (e.g., to reset an Input Channel fader to —es, or
reset a pan setting to Center).

J Ctrl(38)+Shift+Click

Move the cursor to a fader or AUX Send control, then hold down the <Ctrl> key ([38]) and
<Shift> key and click the mouse button to reset the value to the nominal level.
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Using 01V96 Editor Windows

Master Window

W LIWE H
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The Master window enables you to switch between layers and control Stereo Out sig-
nals. To open this window, choose [Master]| from the [Windows] menu.

(1) [ONLINE]/[OFFLINE] button
Repeatedly clicking this button toggles between online and offline status.

Note: If 01V96 Editor is not connected or is not communicating with the 01V 96,

clicking this button will not switch the unit from offline to online.

This indicator is displayed when 01V96 Editor is connected to the
01V96 correctly. If the connection is correct, the 01V96 Editor

parameters will work in unison with the 01V96 parameters.

This indicator is displayed when 01V96 Editor is not connected or is
not communicating with the 01V96, or when you have selected
Offline Edit. If the connection is incomplete, the 01V96 Editor
parameters will not work in unison with the 01V96 parameters.

(@ Meters
These meters display the output level of the oy
Stereo Out when Surround mode is set to
“STEREQ,” or the Bus Outs used for sur-
round processing when Surround mode is
set to 3-1, 5.1 or 6.1. The meters in 3-1, 5.1
and 6.1 Surround modes are shown on the
right.

(3 LAYER buttons

These buttons are used to select the Layers.

LCRS

(4 PAN CONTROL —
These buttons are used to select either
“STEREOQO” (Stereo display mode) or
“SURR” (Surround display mode). The
Pan control on the Input Channels is a rotary control when “STEREO” is
selected, and a dot on a pan graph when “SURR” is selected. If Surround mode is
set to Stereo, the [SURR] button will be disabled.

() Scene number display

This display indicates the currently-recalled scene’s number.

(8) [SELECT] button
This button is used to select the Stereo Out.

(@ [ON] button

This button turns the Stereo Out on and off. It appears orange while the Stereo
Out is on.

Master fader
This is the Stereo Out fader.

(9 Fader value indicator
This indicator indicates the fader position in decibels (dB).
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Layer Windows

The Layer window displays 16 channel strips. You can select a layer using the LAYER buttons in the
Master window. To open the Layer window, choose [Layer] from the [Windows] menu.

Note:

+ You can selectively turn on or off some of channel strips by using the [View] menu.

+ You can open multiple Layer windows by choosing [Windows] menu -> [Layer] -> [Additional View].
The titles of these windows will indicate [Locked]. Windows that are indicated as [Locked] will not
reflect layer changes made on the console or in the Master window. If you want the Layer windows fo
reflect the changes, right-click each window (Macintosh: <control> + click), then select the desired layer
using the LAYER buttons.

Getting Started

1 Input Channels

Selecting the 1-16 or 17-32 button in the Master window displays the corresponding
Input Channel strips.

(1) SOURCE parameter

This parameter is used to select an Input source. To select an Input source, click the
parameter and choose from the list that appears.

(2 Routing buttons
These buttons are used to route the Input Channel to the Bus Outs.

(3 [STEREQ] button
-26.8dB This button is used to route the Input Channel’s signal to the Stereo Out.

(4) [DIRECT] button
This button turns on and off the Input Channel’s routing to its Direct Out.
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(® Direct Out parameter
This parameter is used to select the Direct Out destination. To select a destination,

T click the parameter and choose from the list that appears.
B.Bm=

1 (8 [PHASE] button

This button is used to reverse the signal phase of the channel.

(@ [INSERT] button
This button is used to turn on and off the Input Channel’s Insert.

[GATE] button
This button is used to turn on and off the Input Channel’s Gate.

(9 Gate open/close indicators
These indicators display whether the Gate is open (green) or closed (red).

::-a__-i_--r_--': Gate threshold
o This displays the Gate Threshold, which can be set by dragging.

CH1 1) [COMP] button

This button is used to turn on and off the Input Channel’s Compressor.

(2 Compressor curve
This display shows the Compressor’s curve.

(3 [EQ] button
This button is used to turn on and off the Input Channel’s EQ.

EQ curve

This display shows the Equalizer’s curve, which can be set by dragging.

(5 [DELAY] button
This button is used to turn on and off the Input Channel’s Delay function.
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Delay parameter
This parameter is used to set the delay time of the Delay function. Delay times can be
set by dragging.

(7 Channel number
This is the channel number. Double-click the channel number to open the Selected
Channel window.

AUX section
These controls are used to set the levels of the Aux Sends. To set an Aux
Send level, dragits bar or click a point along the length of the bar. To turn
an Aux Send on or off, click its number.

The following table shows how the Aux Send controls appear depending
on the Aux Send On/Off and Pre/Post settings. Aux Sends can be set to
pre-fader or post-fader on the Selected Channel window (see “AUX
SEND section” on page 15).

Aux Send status Appearance
On or off but no level set Dark blue bar N
Off, pre-fader Green bar outline displays level \\
-~
On, pre-fader Green bar displays level —_
Off, post-fader Orange bar outline displays level =
On, post-fader Orange bar displays level -

Pan/Aux Send display
This display shows the stereo or surround pan position or, while setting an Aux Send,
the Aux Send level in dB.

@0 PAN control
This control is used to set the Input Channel’s stereo or surround pan position.
When the PAN CONTROL in the Master Window is set to “STEREQ,” the Pan con-
trol appears as a rotary control, and when set to “SURR,” the control appears as dot
on a pan graph. The surround pan position can be set by dragging the dot.

@) LFE control
When 5.1 or 6.1 Surround mode is selected, this control is used to set the
surround LFE Channel level. It appears when the PAN CONTROL in the
Master Window is set to “SURR.” To set the Channel level, drag the end of
its bar or click a point along the length of the bar.

@2 [SELECT] button
This button is used to select the Input Channel.

@3 [SOLO] button

This button solos the Input Channel. It appears orange while the channel is soloed.

4 [ON] button
This button turns the Input Channel on and off. It appears orange while the channel
is on.

@9 Short channel name
This is the channel’s short name. To edit the name, click it and type.

@9 Channel fader and channel meter
This is the Input Channel fader. The channel meter to the right of the fader displays
the Input Channel signal level.

@7 Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).

01V96 Editor—Owner’s Manual 9
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d Stero Input Channel

SOURCE
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(1) SOURCE parameter

This parameter is used to select an Input source. To select an Input source, click the
parameter and choose from the list that appears.

(@ Routing buttons
These buttons are used to route the Input Channel to the Bus Outs.

(3 STEREO button
This button is used to route the Input Channel’s signal to the Stereo Out.

(4 PHASE button

This button is used to reverse the signal phase of the channel.

(3 EQ button
This button is used to turn on and off the Input Channel’s EQ.

(8 EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

(@ Channel number

This is the channel number. Double-clicking this will open the Selected Channel
window.

AUX section
These controls are used to set the levels of the Aux Sends. To set an Aux
Send level, drag its bar or click a point along the length of the bar. To turn
an Aux Send on or off, click its number.

The following table shows how the Aux Send controls appear depending
on the Aux Send On/Off and Pre/Post settings. Aux Sends can be set to
pre-fader or post-fader on the Selected Channel window (see “AUX
SEND section” on page 15).

Aux Send status Appearance
On or off but no level set Dark blue bar N
Off, pre-fader Green bar outline displays level \\
-~
On, pre-fader Green bar displays level —_
Off, post-fader Orange bar outline displays level =~ —T—
On, post-fader Orange bar displays level -

(@ Pan/Aux Send display

This display shows the stereo or surround pan position or, while setting an Aux Send,
the Aux Send level in dB.

PAN control
This control is used to set the Input Channel’s stereo or surround pan position.
When the PAN CONTROL in the Master Section is set to “STEREQ,” the Pan control
appears as a rotary control, and when set to “SURR,” the control appears as dot on a
pan graph. The surround pan position can be set by dragging the dot.

(1) LFE control
When 5.1 or 6.1 Surround mode is selected, this control is used to set the
surround LFE Channel level. It appears when the PAN CONTROL in the
Master Section is set to “SURR.” To set the LFE level, drag the end of its
bar or click a point along the length of the bar. @
(2 SELECT button
This button switches between L and R of a stereo input channel.

01V96 Editor—Owner’s Manual 1 0
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(3 SOLO button
This button solos the Input Channel. It appears orange while the channel is soloed.

ON button

This button turns the Input Channel on and off. It appears orange while the channel
is on.

Getting Started

(5 Short channel name
This is the channel’s short name. To edit the name, click it and type.

Channel fader/Channel meter
This is the Input Channel’s fader. The meter at the right of the fader indicates the sig-
nal level.

(7 Fader value
This indicates the dB value of the fader.
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J Output Channels

STERED

INSERT

B.8m=
BUS1

A.a84E

When you select the Master LAYER button in the Master window, the Bus Out and Aux
Send channels are displayed. The Aux Send channel appears the same as the Bus Out
channels except that the Bus Out channels feature a [STEREO] button.

(1 [STEREO] button (Bus Out only)
This button is used to route the Bus Out to the Stereo Out.

(@ [INSERT] button
This button is used to turn on and off the Bus Out’s Insert.

(3 [COMP] button

This button is used to turn on and off the Bus Out’s Compressor.

(4 Compressor curve
This display shows the Compressor’s curve.

(3 [EQ] button

This button is used to turn on and off the Bus Out’s EQ.

(® EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

(@) [DELAY] button
This button is used to turn on and off the Bus Out’s Delay function.

Delay parameter
This parameter is used to set the delay time of the Delay function. Delay times can be
set by dragging.

(9@ Channel number

This is the channel number. Double-click the channel number to open the Selected
Channel window.

[SELECT] button
This button is used to select the Bus Out.

1) [SOLO] button
This button solos the Bus Out. It appears orange while the Bus Out is soloed.

(2 [ON] button

This button turns the Bus Out on and off. It appears orange while the Bus Out is on.

@3 Short channel name
This is the channel’s short name. To edit the name, click it and type.

Channel fader and channel meter
This is the Bus Out fader. The meter to the right of the fader displays the Bus Out sig-
nal level.

(5 Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).
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1 Remote Channels

(CELELT

0N

When you select the REMOTE LAYER button in the Master window, Remote Channels
are displayed.

(1) Channel number
This is the channel number. Double-click the channel number to open the Selected
Channel window.

(@ [SELECT] button
This button is used to select the Remote Channel.

(3 [ON] button

This button turns the Remote Channel on and off. It appears orange while the chan-
nel is on.

Note: When the remote target setting on the 01V96 is set to User Defined, you can
use the [ON] buttons and channel faders to control the functions specified on the
Remote page.

(4 Remote target name
This name indicates the remote target assigned on the 01V96.

(®) Channel fader
This is the Bus Out’s fader.

Note: When the remote target setting on the 01V96 is set to User Defined, you can
use the [ON] buttons and channel faders to control the functions specified on the
Remote page.

(®) Fader value indicator
This indicator indicates the fader position in the range of 0 through 127.

If the remote target is set to User Assignable Layer:

In this case, the assigned channels are displayed. For more information, refer to “Input
Channels” on page 8 and “Output Channels” on page 12. If the Group Master Fader is
assigned, only the [SOLO], and [ON] buttons and channel faders are displayed.

01V96 Editor—Owner’s Manual 1 3
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Selected Channel Window

The Selected Channel window allows detailed editing of the currently selected channel. To open the
Selected Channel window, choose [Selected Channel] from the [Windows] menu.

There are five variations of the layout of the Selected Channel window, as follows:

+ Input Channels (see below)

Getting Started

+  Stereo Input Channels (see page 16)
+  Bus Outs (see page 17)

+  Aux Sends (see page 18)

+  Stereo Outs (see page 19)

Note: You can open multiple Selected Channel windows by choosing [Windows] menu ->
[Selected Channel] -> [Additional View]. The titles of these windows will indicate
[Locked]. You cannot open Library windows from windows that are indicated as [Locked].
In addition, these windows will not reflect the following operations:

* Channel selections made in the Layer window (via the SELECT button)

« Edits in the Surround Editor window

J Input Channels

CHANKEL SELECT IKFUT PRTCH
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(1) CHANNEL SELECT, INPUT PATCH & LIBRARY section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. To edit the name, click it and type. The INPUT PATCH parameter is used to select an input
source. To select an input, click the parameter and choose from the list that appears. The [LIBRARY]
button opens the Channel Library window.

(2) GATE section
This section contains the Gate controls and display graph for the currently selected Input Channel.
The rotary controls are used to set the threshold, range, attack, decay, and hold. The GR meter indi-
cates the amount of gain reduction being applied by the Gate. The OUT meter indicates its output
level. The [ON] button turns the Gate on and off. The [LINK] button links the Gate of the currently
selected Input Channel with the Gate of its partner channel. The KEY IN parameter is used to select a
Gate trigger source. The [LIBRARY] button opens the Gate Library window.

01V96 Editor—Owner’s Manual 1 4



(3) EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Input Channel. The
rotary controls are used to set the gain, center frequency, and Q of each band, and the pre-EQ attenuation
level. EQ can also be set by dragging the EQ curve on the EQUALIZER graph. The [ON] button turns the
EQ on and off. The TYPE buttons select the EQ type. The [LIBRARY] button opens the Equalizer Library
window.

(4 DELAY & PHASE section
This section contains the delay and phase controls for the currently selected Input Channel. The rotary
controls are used to set the delay time, feedback gain, and mix balance (wet/dry balance). The [ON]
button turns the Delay on and off. The [PHASE] button reverses the channel’s signal phase.

(5 ROUTING, PAN & level section

This section contains the routing, pan, and level controls and the [SOLO], and [ON] buttons for the
currently selected Input Channel. ROUTING buttons 1-8 are used to route the channel to the Bus
Outs. The [STEREO] button routes the channel to the Stereo Out. The [DIRECT] button routes the
channel to its Direct Out, and the Direct Out parameter below it selects a Direct Out destination. The
[EPAN] button turns on and off the Bus Out Follow Pan function. The PAN control is used to pan the
channel. The [SOLO] button is used to solo the channel, the [ON] button, to turn on and off the chan-
nel, and the channel fader, to set the channel level. The meter to the right of the fader indicates the
signal level, and the value indicator under the fader indicates the fader position in decibels (dB).

(6) AUX SEND section
This section contains the Aux Send controls for the currently selected Input Channel. Use the rotary
controls to set the Aux Send levels, and click them to turn Aux Sends on and off. Use the button below
each Aux Send control to select pre-fader or post-fader. In Fixed mode, this button is used to turn Aux
Sends on and off (the level is fixed at nominal).

Getting Started
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When Aux Sends are paired, a heart icon is displayed between them, and the odd-numbered Aux Send
control sets the level, while the even-numbered control works as a pan control.

(@ INSERT section
This section contains the Insert parameters for the currently selected Input Channel. The [ON] button
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert
in the signal path.

COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Input
Channel. The rotary controls are used to set the threshold, ratio, attack, release, gain, and knee. The
GR meter indicates the amount of gain reduction being applied by the Compressor. The OUT meter
indicates its output level. The [ON] button turns the Compressor on and off. The [LINK] button links
the Compressor of the currently selected Input Channel with the Compressor of its partner channel.
The POSITION parameter is used to specify the position of the Compressor in the signal path. The
ORDER parameter is used to specify the order of the Compressor and Insert when both are inserted
at the same position. The [LIBRARY] button opens the Compressor Library window.

(9 PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected
Input Channel. Click the heart icon to pair and unpair the channel with its partner chan-
nel. Use the FADER GROUP buttons to add the channel to Fader groups, and use the
MUTE GROUP buttons to add it to Mute groups.
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1 Stereo Input Channels

CHAMNEL SELECT INPUT FRTCH
¥1-1

[I ST N 1L I’

STEREOD N1 LIERARY'

EQUALIZER

Getting Started

W | LiBRARY HRdB
— TYPE—
i TYPET

ATT - =

(1) CHANNEL SELECT, INPUT PATCH & LIBRARY section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. To edit the name, click it and type. The INPUT PATCH parameter is used to select an input
source. To select an input, click the parameter and choose from the list that appears. The LIBRARY
button opens the Channel Library window.

(2 PHASE section
This section contains the phase control for the currently selected Stereo Input Channel. The PHASE
button reverses the channel’s signal phase.

(3) EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Stereo Input Chan-
nel. The rotary controls are used to set the gain, center frequency, and Q of each band, and the pre-EQ
attenuation level. EQ can also be set by dragging the EQ curve on the EQUALIZER graph. The ON
button turns the EQ on and off. The TYPE buttons select the EQ type. The LIBRARY button opens
the Equalizer Library window.
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(@ Routing, pan & level section

This section contains the routing, pan, and level controls and the, SOLO, and ON buttons for the cur-
rently selected Stereo Input Channel. ROUTING buttons 1-8 are used to route the channel to the Bus
Outs. The STEREO button routes the channel to the Stereo Out. The DIRECT button routes the chan-
nel to its Direct Out, and the Direct Out parameter below it selects a Direct Out destination. The
EPAN button turns on and off the Bus Out Follow Pan function. The PAN control is used to pan the
channel. The SOLO button is used to solo the channel, the ON button, to turn on and off the channel,
and the channel fader, to set the channel level.

(5) AUX SEND section
This section contains the Aux Send controls for the currently selected Stereo Input Channel. Use the
rotary controls to set the Aux Send levels, and click them to turn Aux Sends on and off. Use the button
below each Aux Send control to select pre-fader or post-fader. In Fixed mode, this button is used to
turn Aux Sends on and off (the level is fixed at nominal).

When Aux Sends are paired, a heart icon is displayed between them, and the odd-numbered Aux Send
control sets the level, while the even-numbered control works as a pan control.
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(6) FADER GROUP & MUTE GROUP section
This section contains the Fader and Mute group functions for the currently selected Stereo Input
Channel. Use the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.

(1 Bus Outs

CHAMEL SELECT
BUST
4 D)

BUS1 LIERARY

EQUALIZER
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(1) CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

(2) EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Bus Out. It’s layout
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for
more information.

(3) DELAY section
This section contains the delay controls for the currently selected Bus Out. The rotary control is used
to set the delay time, and the [ON] button turns the Delay function on and off.

(4) TO STEREO & level section
This section contains the TO STEREO, pan and level controls and the [SOLO], and [ON] buttons for
the currently selected Bus Out. The TO STEREO button routes the Bus Out to the Stereo Out, and the
rotary controls are used to set the Bus to Stereo send level and pan. The [SOLO] button is used to solo
the Bus Out, the [ON] button, to turn the Bus Out on and off, and the channel fader, to set the Bus
Out level. The meter to the right of the fader indicates the signal level, and the value indicator under
the fader indicates the fader position in dB.

(5 INSERT section
This section contains the Insert parameters for the currently selected Bus Out. The [ON] button turns
the Insert on and off. The OUT and IN parameters are used to select the insert out destination and

insert in source respectively. The POSITION parameter is used to specify the position of the Insert in
the signal path.
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(6) COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Bus Out.
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section”
on page 15 for more information.

(D PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected
Bus Out. Click the heart icon to pair and unpair the channel with its partner channel. Use
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.

J Aux Sends

CHAMWEL SELECT

[ I AUXT I 1

HUX1 LIERARY

EQUALIZER
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(1) CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

(2 EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Aux Send. It’s layout
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for
more information.

(3) DELAY section
This section contains the delay controls for the currently selected Aux Send. The rotary control is used
to set the delay time, and the [ON] button turns the Delay function on and off.

(@ Aux Send level section
This section contains the [SOLO], and [ON] buttons and the channel fader for the currently selected
Aux Send. The meter to the right of the fader indicates the signal level, and the value indicator under
the fader indicates the fader position in decibels (dB).

(5 INSERT section
This section contains the Insert parameters for the currently selected Aux Send. The [ON] button
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert
in the signal path.
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(6) COMPRESSOR section

This section contains the Compressor controls and display graph for the currently selected Aux Send.
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section”
on page 15 for more information.

(D PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected
Aux Send. Click the heart icon to pair and unpair the channel with its partner channel. Use
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE
GROUP buttons to add it to Mute groups.

(1 Stereo Out

CHAMWEL SELECT

[I STEREQ-L I’

STERED LIERARY

EQUALIZER

) LIERARY

INSERT out
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(1) CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

(2 EQUALIZER section
This section contains the EQ controls and display graph for the Stereo Out. It’s layout is identical to
the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 15 for more infor-

mation.

(3) DELAY section
This section contains the delay controls for the Stereo Out. The rotary control is used to set the delay
time, and the [ON] button turns the Delay function on and off.

(@) Balance & level section
This section contains the balance control, [ON], and channel fader for the Stereo Out. The meter to
the right of the fader indicates the signal level, and the value indicator under the fader indicates the
fader position in decibels (dB).

(5 INSERT section
This section contains the Insert parameters for the Stereo Out. The [ON] button turns the Insert on
and off. The OUT and IN parameters are used to specify the insert out destination and insert in source
respectively. The POSITION parameter is used to specify the position of the Insert in the signal path.
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(8) COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Stereo Out.
Its layout is identical to the COMPRESSOR section for Input Channels except there is no [LINK] but-
ton. See “COMPRESSOR section” on page 15 for more information.

(7 FADER GROUP & MUTE GROUP section
This section contains the Fader and Mute group functions for the Stereo Out. Use the FADER GROUP
buttons to add the Stereo Out to Fader groups, and use the MUTE GROUP buttons to add it to Mute
groups.
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Library Window

The Library window enables you to control and manage Scenes and libraries. In addition, Scenes and
libraries can be saved to disk on your computer as Library files.

To open the Library window, choose [Library] from the [Windows] menu. The Library window con-
sists of 8 display pages. You can access each of these pages by clicking the tabs along the top of the win-
dow, or by following the action described below:

Getting Started

Library page Action

Channel Library

Gate Library

- [LIBRARY] buttons on the Selected Channel window
Compressor Library

Equalizer Library

Input Patch Library
Output Patch Library
Effect Library [LIBRARY] buttons on the Effect Editor window

[LIBRARY] button on the Patch Editor window

The layout of the Library window pages is the same regardless of which page is selected (the Scene
Memory library is shown below). The Library window consists of two panes. The pane on the left,
called the [FILE] section, displays the status of the currently open library file. The pane on the right,
called the [INTERNAL DATA] section, displays the status of the corresponding library in the console.

You can copy and sort the items in the list (memories) by dragging them between the panes. Within
the same pane, you can copy a memory by dropping it on top of another memory, and you can sort
memories by dropping a memory between two memories. Memory contents can be swapped by hold-
ing down the <Shift> key while dragging. In all cases, the contents of the destination memory are
overwritten. To edit a memory title, click the title, then type.
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(1 File name
This is the file name of the currently open Library file.
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(2) [OPEN] button
This button is used to open Library files.

Note: 01V96 Editor may be unable to open some files stored in SmartMedia. In this case, copy those files
onto a hard disk, then try to open them in 01V96 Editor.

(3) [CLOSE] button

This button is used to close the currently open Library file.

(4 [SAVE] button
This button is used to save the currently open Library file.

(5 [SAVE AS] button

This button is used to save the currently open Library file with a different name.

(® TITLE
This column displays the memory titles.

(D) PROTECT (only for Scene memories)

This column displays padlock icons for protected memories. It also displays an “[E]” (read-only) icon
for preset data.

INPUT PATCH LINK (only for Scene memories)
This column displays the input patch memory numbers linked to the Scene library. When you store
or recall a Scene memory, the linked Input Patch Library memory is stored or recalled at the same
time.

(© OUTPUT PATCH LINK (only for Scene memories)
This column displays the Output Patch memory numbers linked to the Scene library. When you store
or recall a Scene memory, the linked Output Patch Library memory is stored or recalled at the same
time.

[STORE] button
This button is used to store the contents of the library to the specified location.

Note: In the Effect Library page, the number of the internal effect processor to which the store/recall oper-
ation applies is shown above the [STORE] button.

1) [RECALL] button

This button is used to recall the selected memory.

12 [FILE] section
This section displays the contents of the currently open library file.

(@ [INTERNAL DATA] section

This section displays the console’s status of the currently selected library.

Note: If the OFFLINE indicator is selected by the [ONLINE]/[OFFLINE] button in the Master window,
01V96 Editor is not synchronizing with the console. Therefore, this section does not display the console’s
correct status.

[CLEAR] button
This button clears the selected memory from the list.

5 [UNDO] button

This button undoes the last recall, store, copy, clear, sort or titling operation.

Note: In the Library window, you can undo only the most recent operation. You cannot undo any oper-
ations performed prior to the most recent operation.

[PROTECT] button (only for Scene memories)

This button is used to protect or unprotect the selected memory.
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Patch Editor Window

The Patch Editor window is used to patch Inputs, Outputs, Inserts, Effects, and Direct Outs. To open
this window, choose [Patch Editor] from the [Windows] menu. This window consists of five pages,
which you can select by clicking the tabs along the top of the window.

d INPUT PATCH Page

OUTPUT

(1) Channel IDs
These are the Channel IDs.

@ Long channel names
These are the Channel long names. To edit a name, click it and type.

(3 [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

(4 [ALL CLEAR] button
This button clears all patches on this page.

(3 [LIBRARY] button
This button opens the Input Patch Library window.

(6) Port names
These are the Port names.

(@ Patchbay

The patchbay is used to patch input ports to Input Channels. Active patches are indicated by a blue
dot. To make a patch, click a square. To unpatch, click a blue dot.

| Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch. |

Note: Input sources (AD1-AUXS8) that are assigned to a cascade connection (CAS BUSI-CASSOLOR)
cannot be assigned to non-cascade-connected channels (CHI-32).
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1 OUTPUT PATCH Page
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Getting Started

Slot1 CHI OUT

[2]
e
3
[2]
-
£
]
K=
()
©
=
[
o
£
Q
X

(1) Channel IDs
These are the Channel IDs.

(2 Long channel names
These are the Channel long names. To edit a name, click it and type.

(3 [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

(4 [ALL CLEAR] button
This button clears all patches on this page.

(3 [LIBRARY] button
This button opens the Output Patch Library window.

(6) Port names
These are the Port names.

(D Patchbay

The patchbay enables you to patch output ports to Output Channels. Active patches are indicated by
a red dot. To make a patch, click a square. To unpatch, click a red dot.

| Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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J INSERT PATCH Page
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(1) Channel IDs
These are the Channel IDs.

2 Long channel names
These are the Channel long names. To edit a name, click it and type.

(3 [LIBRARY] buttons
These buttons open the Input and Output Patch Library windows.

(4 Port names
These are the Port names.

(® Insert Out Patchbay
This patchbay is used to patch output ports to the Insert Outs of Input Channels, Bus Outs, Aux Sends,
and the Stereo Out. Active patches are indicated by a red dot. To make a patch, click a square. To
unpatch, click a red dot.

(® Insert In Patchbay

This patchbay is used to patch input ports to the Insert Ins of Input Channels, Bus Outs, Aux Sends,
and the Stereo Out. Active patches are indicated by a blue dot. To make a patch, click a square. To
unpatch, click a blue dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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J EFFECT PATCH Page
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EFFECT1

REVERE HALL

EFFECT 4

REVERE PLATE

Windows

Keyboard Shortcuts

(1) Effects processor 1-4 section
This section indicates the effects name assigned to internal Effects processor 1-4. The parameters in
this section are used to select inputs and outputs for Effects processor 1-4.

(2 [LIBRARY] button
This button opens the Input Patch Library window.
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(1) Channel IDs
These are the Channel IDs.

(@ Long channel names
These are the Channel long names. To edit a name, click it and type.

(3 [LIBRARY] button
This button opens the Output Patch Library window.

(4) Port names
These are the Port names.

(5 Patchbay

The patchbay is used to patch output ports to the Direct Outs. Active patches are indicated by a red
dot. To make a patch, click a square. To unpatch, click a red dot.

| Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.
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Surround Editor Window

The Surround Editor window enables you to edit the surround pan position of the currently selected
Input Channel. To open the Surround Editor window, choose [Surround Editor] from the [Win-
dows]menu.

Getting Started

(1) CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. To edit the name, click it and type.
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@ Surround pan graph
The green dot on this graph indicates the surround pan position for the currently selected Input Chan-
nel. The surround pan can be set by dragging the dot. Clicking a speaker icon will move the pan posi-
tion to the position of that icon.

(3 Surround pan position
This is the current surround pan position.

(49 SURROUND MODE parameter
Click this parameter to display the option list and set Surround mode to STEREO, 3-1, 5.1, or 6.1.

() [LFE] control
This rotary control sets the level of the LFE channel.

(8 [DIV.F] control (6.1)/[DIV] control (3-1, 5.1)
This rotary control sets the amount of divergence (i.e., how the Center signal is fed to the Left, Right,
and Center channels). With 6.1 surround, you can set the divergence for both the front and rear. The
[DIV.F] control sets the amount of divergence for the front signal.

(@ [DIV.R] control (6.1 only)

This rotary control sets the amount of divergence for the rear signal.

[LINK] button (6.1 only)
This button is used to link the [DIV.F] and [DIV.R] controls.
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Effect Editor Window

The Effect Editor window enables you to edit the internal effects processors. To open the Effect Editor
window, choose [Effect Editor] from the [Windows] menu.

Note: You can open multiple Effect Editor windows by choosing [Windows] menu -> [Effect Editor] and
making a choice other than [Generic Editor]. The titles of these windows will indicate [Locked]. You can-
not open Library windows from windows that are indicated as [Locked].

When you recall effects, windows that do not indicate “Locked” in the title will be recalled.

Getting Started
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() Effects processor select
These buttons are used to select the internal effects processors.

(2 Effect select section
The EFFECT NAME, TYPE, and IN/OUT are the name, type and I/O configuration of the effect
recalled to the currently selected effects processor. To edit the EFFECT NAME, click it and type. The
[LIBRARY] button opens the Effects Library window.

(3® [IN] button

This button is used to set the metering position to the effects processor’s inputs.

(@ [OUT] button

This button is used to set the metering position to the effects processor’s outputs.

(5 Meters
These are input or output meters for the currently selected effects processor.

() Effect parameter section

This section contains the various effects controls, buttons, and displays. Its layout depends on the
selected effect type.

(@ [MIX BALANCE] control

This control enables you to adjust the balance between the wet and dry signals. When set to 0, only the
dry signal is heard. When set to 100, only the wet signal is heard.

[BYPASS] button
This button is used to bypass the currently selected effects processor.
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(9) PLAY/REC section
This is shown only if the selected effect type is FREEZE. To start record-
ing (sampling), click the [REC] button and then click the [PLAY] but-
ton. The progress bar shows the current recording location. To play
back the recorded sample, click the [PLAY] button.

FLAY'#REL

Getting Started

TEMPO section
This is shown only if the selected effect type includes a TEMPO param-
eter. You can turn the rotary knob to set the TEMPO parameter
directly. If you turn on the [MIDI CLK] button, the tempo will syn-
chronize with MIDI Clock messages from an external device. If you
repeatedly click the [TAP TEMPO] button, the TEMPO parameter will : ™ O TRE TERPD
be set to the corresponding interval. . F

TEMFD

128 BFM | 1T MION CLE

1) SOLO section
This is shown only if the selected effect type is M.BAND DYNA. Only

the bands that are turned on will be output. If all bands are turned on e o
or off, all bands will be output. SRS ERTLINE BEHTL

s0L0

Keyboard Shortcuts
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Meter Window

©
. . . []
The Meter window displays the Input, Output, Effect, and Stereo Out meters. To open the Meter win- "g
dow, choose [Meter] from the [Windows] menu. This window consists of four display pages. You can &
access these pages by clicking the tabs along the top of the window. >
Page Function %
CH1-32 page This page displays the Input Channel CH1-32 meters (12 segments). )
ST IN page This page displays the Stereo Input Channel 1-4 meters (12 segments)
MASTER page This page displays the Bus 1-8, Aux 1-8, and Stereo meters (12 segments).
Effects 1-4 page H‘f page displays the Channel 1 & 2 input/output meters (12 segments) for Effects
Stereo page This page displays a bar graph (32 segments) of signal levels output to the Stereo Out.

The layout of the Meter window pages is the same regardless of the page selected. (The Master page is
shown below.)

METER MODE FOSITION

| PEAK_HOLD
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(1) Meter mode
You can select the type of meters to be displayed from the following options:

GATE GR:  The meters indicate the amount of gain reduction being applied by the channel Gate.

COMP GR: The meters indicate the amount of gain reduction being applied by the channel
Compressor.

LEVEL: The meters indicate the channel level.

(2 POSITION parameter

This parameter, available only when Meter mode is set to Level, enables you to select the metering
position in the signal path.

(3 PEAK HOLD button
This button turns the Peak Hold function on and off.
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Keyboard Shortcuts

Menu Action Windows Macintosh
Creates a new Session Ctrl+N 3B +N
File menu Opens a previously saved Session Ctrl+O * +0
Saves the current Session Ctrl+S 38 +S
Undo Ctrl+Z P +7
Edit menu
Redo Ctrl+Y 3B +Y
Closes the active window Ctrl+W B +W
Closes all windows Ctrl+Alt+W 38 +Option+W
Opens the Master window Ctrl+1 38 +1
Opens the Layer window Ctrl+2 B +2
Opens the Selected Channel window Ctrl+3 3B +3
Windows menu
Opens the Library window Ctrl+4 3B +4
Opens the Patch Editor window Ctrl+5 3} +5
Opens the Surround Editor window Ctrl+6 8 +6
Opens the Effect Editor window Ctrl+8 B +8
Opens the Meter window Ctrl+9 ?+9
Selects consecutive multiple items (memories) Shift+click shift+click
Library window Selects non-consecutive multiple items (memories) Ctrl+click I8 +click
Selects all memories in a section Ctrl+A 3B +A
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Index

Numerics
1-16 BULtON veevereeerererererererereerenen 7
17-32 DULtON .evveveerererererereerereenenen 7
A
ALL CLEAR button ................ 23,24
AUTO SETUP button ............ 23,24
AUX SECION .eveerevrererereerereeerenrenns 10
AUX SeCtion .....cccceeereereeeereeeeceenrennens 9
Aux Send level section .................. 18
AUX SEND section ........co...... 15,16
Aux Sends ....oeeverereneereereereeerenne 18
B
Balance & level section .................. 19
Bus Outs ..oeeeeeeeieeeeeeeeeeeeene 17
BYPASS button ......ccceceeverevvereenenen. 29
C
CHI1-32 page ....ccooeveeevvecneruincnnnnenene 31
Channel Copy Parameter ............... 3
Channel fader .......... 9,11,12,13,16
Channel IDs ................. 23,24,25,27
Channel Library ......cccceceevevcureecnne 21
Channel meter .........cueu..... 9,11,12
Channel number ........... 9,10,12,13
Channel Select ......ccoeeevererevereenene. 3
CHANNEL SELECT section

............ 14,16,17,18,19, 28
CLEAR button ......ceeeveveververeerenes 22
CLOSE button ......cceevevverevvereenennns 22
COMP button ...eeeeeeeeeeeeeerenne 8,12
Compressor CUrve .......oeeeeeeuene 8,12
Compressor Library ... 21
COMPRESSOR section

........................ 15,18,19,20
Configuring the Editor ............c.... 2
Confirmation ........cceeeeevereveeerereenenes 3
Console -> PC .uveveeeeeeeeeeeeene. 3,4
Console Device ID ........cevevvrenennene. 2
Console Setup ....cceevevcerereueerereerenenns 3
COPY wvereremeneeerererereresseresesesenenecsenene 6
Creating a new Session ........cceceeen. 4
Ctrl + click v 6
Ctrl + Shift + Click ..ocvevereererennneee. 6
D
DELAY & PHASE section ............ 15
DELAY button ...ccceeeeeeeeeeeenenee 8,12
Delay parameter .......c..ccoccureeee. 9,12

DELAY section .......ccccceuene 17,18, 19
DIRECT button .....ccceeeeeeeenene. 8,16
Direct Out parameter ................ 8,16
Direct out patch page ......c.oeeuene. 27
DIV.F control/DIV control .......... 28
DIV R control (6.1 only) .............. 28
dry signal .....cooceeveeeveeinneneneeenenene 29
E
Effect editor window ........c..cccue.... 29
Effect Library ....cococveeceeevecurencunenee 21
EFFECT NAME ......ccoooevniiinnne 29
Effect parameter section ............... 29
Effect patch page ......ccocoveveveerennene 26
EFFECT TYPE ....oceviviriiireininne 29
Effects 1-4 page ...cccooceceevecrrencucnnee 31
Effects processor 1—4 section ....... 26
Effects processor select .........c...... 29
EQ button ....cceeevvveevenvenennene. 8,10, 12
EQ curve ....eeeveeveennennn 8,10,12, 16
Equalizer Library .......c.cceeeveveeeee 21
EQUALIZER section

................... 15,16,17,18,19
F
F.PAN button .....ccceeeceeeeecurencunenes 16
FADER GROUP buttons

................... 15,17, 18,19, 20
FADER GROUP section

................... 15,17, 18,19, 20
Fader value indicator ....... 7,9,12,13
File name ......ccceveeeureecuverccurencuennee 21
FILE SECtiON ....cccecuemererivnccncnenennne 22
G
GATE button ......ceeeeeeeevcuverecerenenne 8
Gate Library .....ccecveecvevencrrencueenee 21
Gate open/close indicators ............. 8
GATE section .....cceeeveveeeevereeenenene 14
Gate threshold .......cccccevvverececcnnnnne 8
Group Master Fader ........ccoecueee. 13
I
IN DULEOTN c.vvvrereeeeeecirieeeeeaeiniene 29
INAEX covrereeririeieeeeeirieereeeeeeieene 33
Input Channels ......c.c.cceeeeureenne. 8,14
Input Patch Library ......ccoeeveueunne 21
INPUT PATCH LINK ........ccceunee 22
Input patch page ......ccoceveveveerenene 23
INPUT PATCH section .......... 14,16
Input Port/Output Port ................. 2

INSERT button .........ceeeeeeevennnes 8,12
Insert In Patchbay ........cccoovveuruneece. 25
Insert Out Patchbay .......cccccuuneeee. 25
Insert patch page .....ccccoceeveverrenenee 25
INSERT section ........... 15,17,18,19
INTERNAL DATA section ........... 22
K
Keyboard shortcuts .......ccoceeueneeee. 32
L
LAYER button ........ccceeeeeeee. 7,12,13
Layer Select ...ccocoevevenenccenencureneueenes 3
Layer Windows ........c.eeceevercereneueenee 8
Level Meter ....cooeeeeerenencrcrerennereneaes 3
level section .......ccceveveveecucrereunenenee 15
LFE control ....cceeeveeveeeennee. 9,10, 28
Library
Channel .....cccocoeerreneveceennene. 21
COMPIESSOT ..eveeeervenereveneervenes 21
Effect oo 21
Equalizer .....ccoceeverenenercreinnnenene 21
GaALe e 21
Input Patch .....ccoovveeeveerernienen. 21
Output Patch ...ccveveeevecnnee 21
LIBRARY button
...... 16, 17, 23, 24, 25, 26, 27
LIBRARY section ........cccoeeeueuvurucnce 14
Library Window ......c.ccecevevecuenennes 21
LINK button (6.1 only) ........c........ 28

Long channel names ...23, 24, 25, 27

M
Master fader ......ooovvveeveeereceerrererenens 7
MASTER page .....cocvvreivencirincnnn. 31
Master Window ........cceeeeeeverecvenenene 7
Meter mode ......ceeevereeeereeeererenennen 31
Meter Window .......cceeeveverennnnen. 31
MELETS evveeeeeeieiecreeecccreeeenee 7,29
MIX BALANCE control ............... 29
MUTE GROUP buttons

.................. 15,17, 18,19, 20
MUTE GROUP section

.................. 15,17, 18,19, 20
(0
()5 11 s T 7
Offline Edit weeeeeeeeeeeeeeeeeeeeeeene. 4,7
ON button ..... 7,9,11,12,13,16,17
ONLINE/OFFLINE button ............ 7
OPEN button ......cceeeevevereeveneenne. 22
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Opening a previously saved Session

............................................ 4
OUT button .....ceeeeeveeverrerereereerennes 29
Output channels .......cceceeurevcurecnne 12
Output Patch Library ......c.occcuueeceee 21
OUTPUT PATCH LINK .............. 22
Output patch page ......cocoereverreeenne 24
P
Pair icon .....ccoeeveveevennne 15,17,18,19
PAN CONTROL ......cooeverererereenene. 7
PAN control .....oeeeveeeennne. 9,10, 16
PAN SECtION ..veveeverererereereeerensennes 15
Pan/Aux Send display .............. 9,10
o ) (R 6
Patch editor window ...........cuu..... 23
Patchbay .....ccccoevevecrennunnee 23,24,27
PC -> Console .....eeeeeeeeieennene 3,4
PEAK HOLD button ........cccouu... 31
PHASE button ........cceuene... 8,10, 16
Port names ........ccccueuuee 23,24, 25,27
POSITION parameter .........cc..... 31
Pre/post buttons .........cceceeerevcerecnne 16
PROTECT ..o 22
PROTECT button .........cceeveverenee 22
R
RECALL button ......cceeeeveveveeverennne 22
RedO v 5
Remote Channels ..........ccoevevenene. 13
Remote target name .........cceeeuvvnee 13
Resynchronizing 01V96 Editor ......4
ROUTING buttons ............. 8,10, 16
ROUTING section .......ccceeeevvenenne. 15
S
SAVE AS button .......ccceeeveevereenenene 22
SAVE button ......ccceeeeeevereerevvereenenns 22
Saving the current Session .............. 4
Saving the current Session with a

NEW NAIME ..eveerrerrrerrvenvennnes 4
Scene number display ........c.ceceeucee. 7
SELECT button ......... 7,9,10,12,13
Selected Channel Window ........... 14
Short channel name ............ 9,11,12
Shortcuts, keyboard ........cocecueucene 32
SOLO button ................. 9,11,12,16
SOURCE parameter ...........c.c.... 8,10
ST IN PaGe -ceveerererererereererereneneeeaens 31
STEREO button ............ 8,10,12,16
Stereo Input Channel .................... 16
Stereo OUL ..eeeeveeveeveeeeeeeeeeeeeneens 19

Stereo page ....cocevverererereereneeeenene 31
STORE button .....cccceeeeevevecuerennene 22
Surround editor window ............. 28
Surround mode parameter .......... 28
Surround pan graph ........ccecuc... 28
Surround pan position ................. 28
Synchronization ........ccececveveveerencnne 4
Synchronize .......ccoeveeeevevcnenencerencnne 4
Synchronizing 01V96 Editor ......... 4
System Setup ...cccevevereveerereeecccnnae 2

TITLE ..ooveeeeeeeeeeeveeeeveveeeereveeerenens 22
TO STEREO section .........cceeeveen. 17
Total Recall .....ooveuevevereeerereeererennenes 4
TYPE I button .....cceeveeveeveeereneenns 16
TYPE I1 button ......ccceeeeeveverenenens 16

UNAO e 5
UNDO button ......ccceveeevenecrerennene 22
User Assignable Layer .........cc...... 13
User Defined ......cccocevrereveneeerennane 13

\

AYATS 785 015 1 10 8

W

wet SIZNal coeeecereirereneeeeeeenes 29
Window
Layer ..coeeveveviniiiniiccniicienne 8
Library ..., 21
JLY B T 13 ORI 7
LY, U (=3 O 31
Patch editor .......cccoeevevereeerenene 23
Selected Channel .................... 14
Surround editor .........cceevevene. 28
WINAOW evvenrereeerereeerereseeeereenene 7
Window Control from Console .... 3
WindowEffect editor .................... 29

Y

Y56K card ..o 4
Yamaha Web Site .....ccooveveveennnee. 1

U.R.G., Pro Audio & Digital Musical Instrument Division, Yamaha Corporation

© 2004 Yamaha Corporation
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